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Warranty Information
Your IOtech warranty is as stated on the product warranty card.  You may contact IOtech by phone,
fax machine, or e-mail in regard to warranty-related issues.

Phone: (440) 439-4091,  fax:  (440) 439-4093,  e-mail: sales@iotech.com

Limitation of Liability
IOtech, Inc. cannot be held liable for any damages resulting from the use or misuse of this product.

Copyright, Trademark, and Licensing Notice
All IOtech documentation, software, and hardware are copyright with all rights reserved.  No part of this product may be
copied, reproduced or transmitted by any mechanical, photographic, electronic, or other method without IOtech’s prior written
consent.  IOtech product names are trademarked; other product names, as applicable, are trademarks of their respective
holders.  All supplied IOtech software (including miscellaneous support files, drivers, and sample programs) may only be used
on one installation.  You may make archival backup copies.

FCC Statement
IOtech devices emit radio frequency energy in levels compliant with Federal Communications Commission rules (Part 15)
for Class A devices.  If necessary, refer to the FCC booklet How To Identify and Resolve Radio-TV Interference Problems
(stock # 004-000-00345-4) which is available from the U.S. Government Printing Office, Washington, D.C.  20402.

CE Notice
Many IOtech products carry the CE marker indicating they comply with the safety and emissions standards of the
European Community.  As applicable, we ship these products with a Declaration of Conformity stating which
specifications and operating conditions apply.

Warnings, Cautions, Notes, and Tips
Refer all service to qualified personnel.  This warns of possible personal injury or equipment damage under noted
conditions.  Follow all safety standards of professional practice and the recommendations in this manual.  Using this
equipment in ways other than described in this manual can present serious safety hazards or cause equipment damage.

This warning symbol is used in this manual or on the equipment to warn of possible injury or death from electrical
shock under noted conditions.

Use proper ESD handling guidelines when handling equipment or components sensitive to damage from electrostatic
discharge.  Proper handling guidelines include the use of grounded anti-static mats and wrist straps, ESD-protective bags
and cartons, and related procedures.

This symbol indicates the message is important, but is not of a Warning or Caution category.  These notes can be of
great benefit to the user, and should be read.

In this manual, the book symbol always precedes the words “Reference Note.”  This type of note identifies the location
of additional information that may prove helpful.  References may be made to other chapters or other documentation.

Tips provide advice that may save time during a procedure, or help to clarify an issue.  Tips may include additional
reference.

Specifications and Calibration
Specifications are subject to change without notice.  Significant changes will be addressed in an addendum or revision to the
manual.  As applicable, IOtech calibrates its hardware to published specifications.  Periodic hardware calibration is not covered
under the warranty and must be performed by qualified personnel as specified in this manual.  Improper calibration procedures
may void the warranty.

Quality Notice
IOtech has maintained ISO 9001 certification since 1996.  Prior to shipment, we thoroughly test our products and review
our documentation to assure the highest quality in all aspects.  In a spirit of continuous improvement, IOtech welcomes
your suggestions.

mailto:sales@iotech.com




ZonicBook 10-30-01 eZ-TOMAS, pg.  v

1 - Introduction

What is eZ-TOMAS …… 1
Start eZ-TOMAS …… 2
Connecting Signals …… 2
Order of Operation …… 3

2 - Start a New Project

Configure the Project …… 6
Configure the ZonicBook …… 6

Start Monitoring …… 6
View Spectral Bands …… 7
Plot Data …… 7

Multiple Plots …… 7

Generate Limits …… 8
Limit Status Color Code …… 10

Continue Monitoring …… 10
Are Alarms acceptable? …… 10

3 - Windows and Menus

Main Window …… 11
Main Menu …… 12
Instrument Gauges …… 12

Control Panel …… 13
Data Storage Panel …… 14
Relays Panel …… 14
Tach Reference Panel …… 14
Security Level Panel …… 15
Network Panel …… 15
Machine Description Panel …… 16

The Menu System …… 17
File Menu …… 17

New Project …… 17
Open Project …… 17
Save As …… 17
Overlap Data …… 19
Erase History File …… 20
Print …… 20
Exit …… 20

Edit Menu …… 20
ZonicBook Configuration Window …… 20

Acquisition Configuration Tab …… 21
Channels Configuration Tab …… 22
Spectral Bands Tab …… 24
Storage Tab …… 25

Limits …… 26
Relay Outputs …… 28
Communication Panel …… 28
Relay Output Panel …… 28
Network …… 29
Copy Window …… 30
Load Graphic Picture …… 30
Remove Graphic Picture …… 30

View Menu …… 30
Plots Menu …… 30

Data Display Window …… 30
Formatting Options …… 33

Reports Menu …… 41
Statistical Report …… 41

Generate Limits …… 42
Alarm Log Report …… 43

ZonicBook Configuration …… 44
Security Menu …… 45

Change Password …… 45

Glossary …… 46
Additional Notes …… 46

4 - Program Function Keys

Customize tomasfkeys.ini file …… 47



eZ-TOMAS, pg.  vi 10-30-01 ZonicBook



ZonicBook 10-30-01 eZ-TOMAS, pg.  1

Introduction 1

What is eZ-TOMAS …… 1
Start eZ-TOMAS …… 2
Connecting Signals …… 2
Order of Operation …… 3

Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

What is eZ-TOMAS?
eZ-TOMAS (Temporary Online Monitoring and Analysis Software) is designed to collect vibration and
process data from rotating machinery.

eZ-TOMAS can simultaneously monitor, acquire, store, and display data from the ZonicBook FFT
analyzer.  Typically, these signals are associated with a specific machine train.  The analog inputs can be
any combination of Proximity, Velocity, Accelerometer, Tach, or DC proportional voltage signals.
Up to three tach signals are supported.

The data acquired by eZ-TOMAS and the supporting configuration information are stored in files defined
by you. This allows you to move eZ-TOMAS from machine to machine.  The acquired data is stored based
on event changes defined by you.  Defined events include time, overall, and rotating speed.

Acquisition, instrumentation, and storage configuration parameters are also definable.  These parameters
are stored over time.  Configuration changes do not invalidate previously acquired data.

A basic graphical User Interface (UI) is provided.  The UI consists of 8 instrument gauges.  The gauge
display can include any one of 10 spectral amplitudes or frequencies of interest.  You can interactively
display data in a variety of formats, including:  Spectrum, Orbit, Polar, Time, Bode, Cascade/Waterfall and
Strip Chart.
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Start eZ-TOMAS
To run eZ-TOMAS, double-click the eZ-TOMAS icon or use your Windows desktop Start button
to navigate to the program file.

The first time you start eZ-TOMAS you will be prompted for your name, your company name, and
a password.  This password is the software key that will activate eZ-TOMAS for every day operations.

Registration Form

If you are loading your software from a CD the password accompanies the CD.  If you downloaded your
software from the website, your password will be emailed to you within one business day.

You will next be prompted to set up your project’s security password.  When you click the <Save> button
the Password Confirm window opens.  Retype your security password and click the <Confirm> button.

Password Form

After your password is accepted, you are returned to the Main window.

Connecting Signals
Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

Connect your analog signals to the ZonicBook’s BNC inputs. Typically, proximity and DC proportional
signals should be DC coupled; and Accelerometer, Velocity, and Tach signals should be AC coupled.

Prox: SE(single ended) DC ICP off
Accel/Vel: SE AC ICP  on
Tach: SE AC ICP off
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Order of Operation

Start eZ-TOMAS
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Start a New Project 2

Configure the Project …… 6
Configure the ZonicBook …… 6

Start Monitoring …… 6
View Spectral Bands …… 7
Plot Data …… 7

Multiple Plots …… 7

Generate Limits …… 8
Limit Status Color Code …… 10

Continue Monitoring …… 10
Are Alarms acceptable? …… 10

An eZ-TOMAS Project contains eZ-TOMAS configuration and data files.  You should logically equate an
eZ-TOMAS Project with a specific machine that you wish to monitor.

1. On the File Menu, select New Project to open the Save As window.

New File

2. Select or create a Windows folder for the eZ-TOMAS Project.
3. Enter the name for this project.
4. Click the <Save> button to create the new project.
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Configure the Project
A default configuration is automatically loaded.  You may want to make some changes to the
configuration.  However, you can start monitoring immediately.

Configure the ZonicBook
On the Edit menu select ZonicBook to open the ZonicBook Configuration window.  Make the necessary
changes for each of the tabs and then click the <Save> button.

An in-depth explanation of eZ-TOMAS windows and menus is in the next chapter of this
manual.

�������

Clicking the Cancel button will cancel all the changes you’ve made since you
opened this window.

• Acquisition Configuration sets up parameters for the ZonicBook FFT analyzer.
• Channels Configuration sets up the parameters for the input channels.
• In the Spectral Bands Configuration panel the first four Bands are predefined.  You can modify Bands

5 through 10 for your specific application.
• Data storage configuration specifies the trigger events that will activate data storage.  If any one event

is triggered, data from all channels is stored.  Data storage events are triggered when a change occurs
within the range of your defined parameters.

Start Monitoring
After you configure your eZ-TOMAS Project, press the Acquisition Toggle Switch in the Control panel to
start data acquisition.

Control Panel

When acquisition is active, real time overall values are displayed in the instrument gauges.  The toggle
switch is green while data acquisition is active.

To stop data acquisition, click the switch toggling it down (red).

Allow eZ-TOMAS to monitor your machine for several hours, minimum.  eZ-TOMAS needs to create a
history file of the operating condition of the machine.  If the operating condition is “right”  the history file
can be used to generate limits for you.
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View Spectral Bands
You can monitor the different spectral bands by watching the gauges in the Main window.  On the View
menu select the band of interest to view gauge data.

Spectral Bands

Plot Data
Click Plots on the Main menu to open the Data Display window, or double-click on a gauge to plot that
gauge’s data.

For Real Time displays you can Halt and Resume the display of data by using the Pause/Continue toggle button,            , or
use the “P” key on the keyboard .  When viewing historical data, you can use the five playback buttons and the slider to
navigate through the data.

Multiple Plots
1. On the File menu of the Plots window, select Open Plot Window.

This opens a second display window.
2. On the Window menu of the Plots window select either Tile Vertically or Tile Horizontally.

All display windows will be displayed simultaneously, as shown below.

Plots Tiled Vertically

3. Select the Channel(s) and Display type for each window.
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A cursor is provided with each display. To move the cursor, place your mouse icon over the cursor and
drag it to the desired location on the trace. You can also use the comma (,) and period (.) keys to move the
cursor.  Cursor information is listed immediately to the left of the display.

Generate Limits
Statistical reports can and should be used to automatically generate limit values based on historical data.
After your new project has been running for several hours, there is probably enough data in the history file
to have eZ-TOMAS automatically generate limits.  However, you will want to edit these limits if the
machine is experiencing amplitude or frequency shifts.

1. On the Reports menu select Statistical; the History Data window will open

History Data Window

2. Drag the pointers across the scale to select the Start Date and Time, and the End Date and Time for
the report.  Click the OK button.  The Report will then be displayed.

Statistical Report

Limit values are not used if the HiHi  limit value minus the LoLo limit value is less than
5% of the instrument scale OR the limit value is outside the instrument range.
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3. In the Statistical Report window select Generate Limits on the File Menu;
the Limit Generation window will open.

Limit Generation

4. Select the Spectral Bands for which limits should be generated.
5. Specify the Standard Deviation to be used for Alerts and Alarms.  Two High and two Low limits will

be defined for each channel’s operating condition.
6. If you want to change the Overall % Storage Trigger (set in the ZonicBook Configuration window

under the Storage tab), click to place a checkmark in the Compute Using check box and enter the
new standard deviation to be used.

Limit Prompt

7. Click the <OK> button.  You will be asked if you want the Limits saved to disk.  Click <Yes>.
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The limits will be generated and can be reviewed/modified in the Edit Limits window, as shown below.

Edit Limits Window

You can also modify limits on the graphical gauge display in the main window by dragging the limit
arrows.

Limit Status Color Code
Red HIHI (Danger)
Light Purple LOLO (Danger)
Cyan LO (Alert)
Yellow HI (Alert)
Green OK OK

Continue Monitoring
Now that the limits are set, you will be notified of Alerts and Alarms. When the instrument status changes
(Alert or Danger), a single system beep is issued.

Are Alarms Acceptable?
You should periodically display the Alarm Log to see how many alerts and alarms you are getting in a
specific time frame.  If the machine appears to be running in a steady state, but you are getting a lot of
alarms, you may have the limits set too “tight.”  In this case you may want to modify/edit the limits.

On the other hand, if you are getting a lot of alerts and alarms, your machine may need to be adjusted or
repaired.

In either case, you are now monitoring your machine online.  From now on you will need to continue to
View and Analyze your data to help you determine if and when you should schedule a shut down for
maintenance and repairs.
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Windows and Menus 3

Main Window …… 11
Main Menu …… 12
Instrument Gauges …… 12
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Main Window

Main Window
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Main Menu

The main menu is laid out so that when you set up and monitor a typical project you can start with the File
menu on the left and proceed to the right.

Instrument Gauges

Instrument Gauges Panel

Each instrument gauge includes the instrument range, the current value, limit indicators,
peak hold gauge indicator, and the instrument name. The instrument gauges show one of 10 current
acquisition values. On the View menu, select the spectral band of interest.

You can specify Spectral Bands 5 through 10 in the ZonicBook Configuration window (Edit Menu) under
the Spectral Bands tab.  The default definitions are shown below.

There are shortcut (Hot) keys (1 through 0) for each display type.

No. Spectral Band
1 Overall 6 2x Amp
2 DC Gap Voltage 7 3x Amp
3 1x Amplitude 8 4x Amp
4 First Order Phase 9 5x Amp
5 1/2 x Amp 10 6x Amp

Types 1 through 4 can not be modified.  The Overall value is a time domain overall value.
Displacement probes are peak-to-peak, velocity probes are zero-to-peak, and accelerometer probes are
zero-to-rms. Types 5 through 10 are user defined and can be modified at any time.

Peak hold values for all gauges can be displayed by positioning the mouse cursor over any gauge, and
holding down the right mouse button. This will cause the peak value and the date and time that value was
reached to appear below each gauge.
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Control Panel

Control Panel

Acquisition indicates the ON/OFF status of data acquisition.  Click this toggle switch to turn data
acquisition ON (Up/Green) and OFF (Down/Red).

Limit Check indicates the ON/OFF status of the Limit Checking feature.  Click this toggle switch to turn
limit checking ON (Up/Green)  and OFF (Down/Red).

Snap Shot saves the current record and stores it in the history file.

Show Peak Hold Gauge Pointers displays the Peak Hold pointers on each gauge.

Reset Peak Hold Gauge Values resets the Peak Hold Gauges to zero.  This is momentarily
reset because the current acquisition is immediately used.

Instrument Gauge

Limit Indicators

Peak Hold Gauge Pointer
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Data Storage Panel

Data Storage/Alarms Panel

The upper bar is the data storage progress bar.  It graphically indicates how full the FIFO file is.  Below
the progress bar and to the right are two numbers.  The first is the current record number; the second is the
number of records which can be stored in the FIFO file.  The date and time range of the stored data is
displayed to the left.  Double-clicking on the bar or the text opens the plot window.

The lower bar is the Alarm Log progress bar. It graphically indicates how full the Alarm File is.
A single beep is issued when the current record number is within 5% of wrapping.  This is your indication
to backup the eZ-TOMAS Project.  Double-clicking on the bar or the text opens the Alarm Log.

Below the two bars is a “paint chip” that displays the type and color of the last alarm.  Double-clicking on
the “paint chip” opens the Alarm Log.

Relays Panel

Relays Panel

The Relay Panel contains the Relay ON/OFF toggle switch and four relay icons.  The icons indicate the
current status of the relays.  Each time you start eZ-TOMAS, the Relay switch is turned off.  You must turn
on this switch to send output to the relay channels.

If the relay toggle switch is turned on, relays will activate or deactivate depending on the configuration set
in the Relay Outputs Configuration window (accessible under the Edit menu). Each of the four relays can
also be manually activated by clicking on the relay button during an acquisition.

Tach Reference Panel

Tach Reference Panel

The Tach Reference panel displays the tach reference channels.  The tach reference associated with the
currently displayed data, when more than one tach is being used in the monitoring project.
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Security Level Panel

Security Level  Panel

The enabled radio button indicates the current security level.  Level 3 provides full screen and full access
to all menus.  Level 2 provides full screen with limited access to menus.  Level 1 provides full screen with
very limited access to additional screens and menus.

Network Panel

Network Panel

This feature requires multiple copies of eZ-TOMAS, one on each networked computer.  Each networked
computer must have eZ-TOMAS running in order to access the networking functions.  When networked, a
node as set as either a client or a server. A server must be connected to a ZonicBook, and can be monitored
and controlled by a remote client; a client does not need to have a ZonicBook connected, but can effect the
eZ-TOMAS settings on the server.

The Network Panel lists all nodes (computers) networked with this machine.  An S indicates that a
computer is acting as a Server; C indicates it is a Client to the Server; F or a blank space indicates that a
computer is free, not a server nor a client.

To add new nodes, use the Configure Network Nodes window, accessible by selecting Network... under
the Edit menu.

To the right of the list of network nodes, the current status of the network connection is displayed. The
status messages apply only to the current network connection between a client and a server. There are four
status messages which can be displayed:

• When not connected, the message “Listening to Network...” appears.
• While scanning for a ZonicBook, the message “Connecting to <computer name> on port

<number>...”. Port numbers will be searched until a ZonicBook is detected.
• If acting as a client which has connected to a server, the message will read “Received”, followed by a

series of code letters. Below this, the current time will be displayed.
• If acting as a server, and a client has connected, the message “Network Xfer. Delay: <number of

seconds>” will appear, followed by a series of code letters.
Once a network connection is established, a connection icon (two computers connected by an arrow) and a
disconnect button (a large “X”)  will be displayed below the status message. The name of the computer
connected to will also appear below the two buttons.

To connect to a network node, find the computer name you wish to connect to in the network node list,
and left-click on it. eZ-TOMAS will establish the client/server relationship.

To disconnect to a network node, click on the disconnect button, which appears at the bottom of the
network status window.
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Machine Description Panel
In the below graphic “My Machine” is set up in the ZonicBook Configuration window (Edit Menu) under
the Acquisition Tab.  The text box allows further identifying information, such as the Serial Number of the
Machine, or the Plant’s commonly used name for the machine.  If you have a digital picture of the machine
you can load that into this panel also.

Machine Description Panel
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The Menu System

File Menu

New Project
The New Project option opens the Save As window.  Select or Create a Folder where the new project’s files
should be saved.  Enter a project name, and click the <Save> button.

New Project Dialog

Open Project
The Open Project option opens an existing eZ-TOMAS project.  The Open window is displayed.
Select the project of interest, and click the <Open> button.

Open Project Dialog

Note: When eZ-TOMAS is started, it opens the last active project.

Save As
The Save As option allows you to backup history files in a binary file format, or export files in an ASCII
file format.  This command opens the Backup/Save Tomas Project window. The options in this window
change as you make selections. You can backup and export full or partial files.

Note: The disk space required to backup the selected records is displayed on the left panel.
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The Entire Project option is only available when data acquisition
is turned off.  Entire Project performs a file copy operation to the specified Windows Directory.
This backup method is the fastest.

Save As… Entire Project

The Partial Project option can be used when data acquisition is active.  This option copies data and the
configuration setup to the designated folder for the date and time range specified in the panel on the right.

Save As… Partial Project

Select the first and last record numbers you want included in the backup. Click the <Save> button.
The Save As window will open.  Select the folder where the file is to be save,
Enter a name, and click the <Save> button.

Partial Data Backup Panel

From Record #: The first record number of interest.
Start Date/Time: The first date and time of interest.
To Record #: The last record number of interest
End Date/Time: The last data and time of interest.
Destination: Where backup and exported files are stored.
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Backup Format - ASCII
This option creates an exportable ASCII file for the selected data type.  Select ASCII in the panel to the
left.  The panel on the right will activate, unless Alarm log is the pre-selected data type.  Select the type of
data you want exported in the drop down menu.  If you select Gauge or Statistics, select the first and last
records to be included in the exported file.  The entire Alarm Log file is always exported.

Save As… ASCII File

Gauge: exports the 10 bin values shown on the graphic instrument panel.
Statistics: exports the statistical report data.  It opens the History Data Window.
Alarm Log: exports the Alarm Log file.

Overlap Data
Overlapped Data, also known as Consecutive Data Blocking, is used to analyze data from large machine
transients.  It creates better resolution for rapid machine acceleration rates (>100 rpm/sec).  Overlap data
uses the second part of a block of data and overlaps it with the first part of the next block of data to
create a new block of data with an increased number of data points.  When the overlapped data is displayed
in a plot, the resolution is increased for better analysis.

History Data Window

1. On the File Menu select Overlap Data to open the History Data window.
2. Select the start and ending time to be included in the overlap process.
3. Click the <Overlap> button to open the Save As window.
4. Select the destination folder, enter a name and click the <Save> button.

Display this data later by selecting Overlap as the data source in the Plots window.
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Erase History File

Erase History Prompt

Use with caution.  This menu item will erase the History File for
 this project. All data will be permanently removed.  It is not recoverable.

Print
Prints the current screen.

Exit
Closes the eZ-TOMAS application.

Edit Menu
To modify the eZ-TOMAS Project configuration, select “Edit” on the menu bar.

• To configure the Analyzer select ZonicBook.
• To set up the lower and upper alert and alarms select Limits.

ZonicBook Configuration Window
This window has individual panels for configuring the ZonicBook. Click the appropriate Tab at the top of
the window to view the “Acquisition,” “Channels,”  “Spectral Bands,” and “Storage” panels. Make the
necessary changes in each panel. Click the <Save> button to save all your changes and close the window.

Clicking the Cancel button will cancel all the changes you’ve made since you opened
the window.
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Acquisition Configuration Tab
This tab is used to configure how the ZonicBook will process acquired data.

ZonicBook Acquisition Tab

Block Size: is the number  samples per block of vibration data.  For example, a 2048
Block size contains 2048 data samples and will produce an 800 line spectrum.
A larger Block size provides greater data resolution.  However, it takes longer
to collect the data and more disk space to store it.

Analysis Frequency: is the maximum frequency of interest.  The sampling rate will be 2.56 times
the analysis frequency.  Verify the maximum frequency response of your
probes.  For a Tach signal, your Analysis Frequency should be a higher
multiple of the maximum rotating speed.  Typically, this multiple is at least
10 times the rotating frequency.

Low Frequency Cutoff: Allows you to eliminate the lower frequencies from the full frequency range.
Number of Averages: The number of data blocks averaged before a block of data is accepted and

displayed.
FFT Window
(Weighting window):

is typically either Hanning or Flat Top. Hanning provides better frequency
resolution. Flat Top provides better amplitude resolution.

RT Display Buffer: This option is primarily for Strip Chart Displays.  It controls the amount of
time that is displayed across the x-axis.  Your choices are up to 480 minutes.
The longer times are especially useful when you are trying to see trending for
a slow process.

No. of Waterfall
Traces:

This selection allows control over the number of traces that appear on a
waterfall chart display, selectable in the Plots window. A high number of
traces will increase the resolution of the chart, but a low number of traces
may be preferable for plots which do not have clearly defined peaks.

Machine Name: Type a machine name in the data entry box.  This name will appear in the
lower right corner of the Main Window.

You must turn acquisition off and then on again for Acquisition Configuration changes
to take effect.
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Channels Configuration Tab
This tab is used to configure each channel for your project.  The available setup options in this window are
dependent on the instrument type selected.

Select a channel; then set the instrument type and set the value for each attribute.  Repeat for each channel.

The parameters of one channel can be copied to another channel by using options on the
Edit menu.

ZonicBook Channels Tab

Configure the DipSwitches for each probe based on probe type.
Refer to the ZonicBook Getting Started Manual for more information.

No.: is the channel.  Selecting the channel number highlights all attributes for that
channel.

Type: is the type of instrument attached to the channel.  Your options are
Accelerometer, Velocity, X Probe, Y Probe, Z Probe, Static and Tach.  If the
channel does not have an instrument attached, select Unused.

Name: is a Label you will use to identify the channel.
Min, and Max: represent the instrument range.
Units: is the Engineering Units you want to use.  Your options are mils or microns.
FSV
(Full Scale Voltage):

is the maximum input voltage for the instrument.  If you are unsure of the
instrument’s maximum voltage value, select a high voltage value.

mVolt / EU: is the instrument sensitivity.  (Typical displacement probes: 200 milli-Volts per
mil.  Typical accelerometer probes: 100 milliVolts per G.  For Tach probes
enter 1000.) For static channels, this property represents the slope variable of a
linear equation (the “m” of “y=mx+b”).

Integration: Accelerometer and Velocity signals can be integrated.  Select the desired
integration value.  If the signal is acceleration, then single integration results in
velocity, and double integration results in displacement. If the signal is velocity,
then single integration results in displacement.
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Integration Units: are g’s/ips/mils, g’s/ips/mils, g’s/ips/in, and g’s/mmps/mm.
Angle: is the physical angular location of a probe.  Zero degrees is defined to be the

top dead center.  The angle value is measured in the counterclockwise (CCW)
direction as viewed from the driver end.  For example, if your proximity probe
is located in the top dead center of the bearing housing,
the Instrument Angle is 0 degrees.  Orbit and Polar displays utilize Instrument
Angle for data correction.

Gap Volt: is the DC voltage value when the shaft is at rest.  This value is used for Shaft
Center Line displays.

1xAmpRef and
1xPhsRef:

are the slow roll values used for Runout Compensation on Bode or Polar
displays.

Rotation: is the shaft’s rotation direction, either clockwise (CW) or counter-clockwise
(CCW), as viewed from the driver end of the machine train.

Trig/Rev: is the number of pulses per 360 degree revolution. (Default: 1)
Trig Dir: is the “negative’ or “positive” direction of the moving shaft.
Trig Volt: define the Tach pulse for tach signals.  A keyway will generate a Negative

Tach pulse.  Typical Tach signals will generate at least a 1 V pulse.  You can
check the voltage value using a TIME display.  For Static channels, this
column represents the offset variable of a linear equation
(the “b” of “y=mx+b”)

Paired To: associates 2 probes on a bearing.  Typically, probe pairs are located 90 degrees
apart.  Orbit displays require a Channel Pair.  If you have a Tach signal or
displacement probe, you also need to configure the Channel Pairs.  [Default:
No channels are paired.]

Bearing Clearance: is measured in the instrument’s engineering units.  You can optionally overlay
the bearing clearance circle onto an orbit display.



eZ-TOMAS, pg.  24 10-30-01 ZonicBook

Spectral Bands Tab
Up to 10 Spectral Bands of interest can be defined for each dynamic channel.  The first four Bands are
predefined.  You can modify Bands 5 through 10 for your specific application.  Spectral Band values are
displayed on the dynamic instrument gauges.

ZonicBook Spectral Bands Tab

Tach Reference: is (are) the tach channels being used in the project.  You must select the
tach of interest.

Channel Name: is the name you assigned to the input channel in the Channels Panel.
Band: is the Spectral Band Number  (5 through 10) of interest.
Spectral Band Name: is the name you assign to this Band.  It is displayed on the dynamic

instrument gauge in the main window.
Range Low and Range High: is the frequency or order range.  Suggestion:  Make sure the range is

2 to 4 spectral lines wider than the frequency of interest.  This is due to
the FFT window.  For example, if your frequency of interest is the 3rd

order.  You should specify a range of 2.9 to 3.1 orders
Units: can be either Frequency or Orders.  If you do not have a tach defined, the

Orders option is not available.
Find: specifies Peak or Overall.  Peak is the highest spectral amplitude within

the specified range.  Overall is the vibrational sum of each spectral
amplitude within the specified range.
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Storage Tab

ZonicBook Storage Tab

Data storage is activated by trigger events.  If any one event is triggered, data from all channels is stored.
Data storage events are triggered when a change occurs within the range of your defined parameters.  You
can configure the system to store data every:

“N” seconds (Time Change), and/or every

“N” RPM (Speed Change), and/or

“N” % change in Full Scale Voltage (Overall Change).

For example, if your Overall Change trigger is set to 5% and the instrument scale is 0 to 5 mils,
eZ-TOMAS will store time and spectral data for all channels when the overall value changes by 0.25 mils
since the last trigger event.  All event triggers are reset whenever any event trigger occurs.

Time Change: is a time-based storage trigger.  Enter the number of seconds, minutes, hours, or days
between desired storage events.

Speed Change: is an RPM based storage trigger.  Data will be stored when the machine speed
changes by the defined value in rpm, Kcpm, or Hz.

Overall Change: is an amplitude-based storage trigger that can be defined for each channel.  Data is
stored when the overall amplitude changes by the percentage of Full Scale specified.
[Default: 5% of full scale]
This can be controlled on a channel-by-channel bases by selecting “True” or “False”
in the Enabled column.

RPM Range: The range in which a one of the above changes must occur to trigger data storage.
Storage options can be Data Only, Alarms Only, Data and Alarms, or Not Enabled.
When Not Enabled is selected, any of the above changes can cause data to be stored
regardless of the frequency range in which it occurs.

Data File Size: is the number of storage records and the number of Alarm Records in the History
FIFO (First-In-First-Out)  file.  The amount of disk space needed, based on your
configuration, is shown to the right

eZ-TOMAS maintains several data files, including Time and Gauge data.  Gauge data can be displayed in
the gauge display window.  The history file is a FIFO file.  You can define the depth of the history file;
however, the amount of time needed to fill the file depends on the trigger event values.  The smaller the
trigger values, the faster the history file fills.  The current data storage status is shown in the Main Window.
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Limits
There are two ways to generate and modify limits. The global way is to use the statistical report.  Statistical
reports can and should be used to automatically generate limit values based on historical data. The Limits
window is used when you want to modify specific limits. It is not an efficient  way to generate limits.

For more details on setting limits refer to the section Statistical Report

Edit Limits

Up to two High and two Low limits can be defined for each channel’s operating condition.

When the instrument status changes (Alert or Danger), a single system beep is issued.

Limit values are not used if the HiHi minus the LoLo limit value is less than 5% of
instrument scale OR the limit value is outside the instrument range.

The limits from one channel can be copied to another channel using options on the Edit
menu..

Limit Status Color Code

Red HIHI (Danger)
Light Purple LOLO (Danger)
Cyan LO (Alert)
Yellow HI (Alert)
Green OK (Within Limits)
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Tach you may have up to three tachs per project.
Channel Number of interest.  The Instrument Name you assigned to the channel is

automatically displayed.
Spectral Band to which the limits should be applied. ( i.e. Overall, DC Gap, 1xAmplitude,

1xPhase)
HIHI, HI, LO, LOLO are Limits.  Type limit values in the table.

You can modify limits on the graphical gauge display in the main window by dragging the
limit arrows and then opening this window to save your changes.

Files is the number of Alarm event files.  When a Red Alarm occurs, eZ-TOMAS
automatically saves data surrounding the event to an Alarm Event file.

Pre Recs is the number of records prior to the alarm.
Post Recs is the number of records after the alarm.
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Relay Outputs

Output Relay Configuration

Use this panel to configure the responses of your output relays Automation Module.  This device allows
you to have relay switches open and closed based on limit/alarm status.  You can use up to four relays.

The color of the response channel in the Relay Output panel indicates the limit/alarm status that will cause
the relay to change status (open/close).  Click on a channel number until the desired limit color  is
displayed.  If the relay is normally open  when monitored data causes the specified limit/alarm, the relay
will change to close for the duration specified by the timer; and then it will reopen.

Additionally, you can have the system count the number of consecutive alarms and change the relay status
when that number of alarms is reached.

Communication Panel
The following conditions must be met for proper output of each device.

Device:  The Output Relay module (currently 1).

COM Port:  Select the COM Port to which the output Relay module is connected.

Relay Output Panel
Relay button:  The number of the relay.  Up to 4 can be used. Click on this button to activate or deactivate
the relay.  Green = ON/activated, Red = OFF/deactivated.

buttons:  Sets the default state (normal operating state) of the relay.

         = Normally Open and               =  Normally Closed.

Timer:  The amount of time required for a part to pass through the open gate.

When you click the Save button, any of the unchecked check boxes for relay channels
will close and stay closed until the condition is met for that relay channel.  If you have
something that will actuate when the channel closes, it will do so as soon as you click the
Save button.
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Network
Networking requires your eZ-TOMAS monitoring system to be connected to a network with at least one
other PC running an additional copy of the eZ-TOMAS.

Configure Network Nodes

This feature requires multiple copies of eZ-TOMAS. Each networked computer must have eZ-TOMAS
running in order to access the networking functions. When networked, a node as set as either a client or a
server. A server must be connected to a ZonicBook, and can be monitored and controlled by a remote
client; a client does not need to have a ZonicBook connected, but can affect the eZ-TOMAS settings on the
server.

The Configure Network Nodes window (accessible from the Edit...Network menu) allows you to add
remote computers to the list of available network nodes. Computers which have been added are displayed
in the network panel of the main eZ-TOMAS screen. To add a computer, complete the following fields in
the Configure Network Nodes window:

Name / I.P. Address should be filled with either the computer’s network name, or its IP address. Your
network administrator should know both of these values.

The Project password is your security level password.

Delay is the rate in seconds that the client computer will be updated by the server computer.

Port Timout Delay is the amount of time that eZ-TOMAS will scan a computer’s port for a ZonicBook. If
the timeout is reached, eZ-TOMAS will search the next port, until all ports have been scanned.

Networking eZ-TOMAS allows you to monitor and control acquisitions from a distance. For instance, if
you are monitoring a fan with eZ-TOMAS somewhere in the plant and you also have a PC in your office
with a second copy of eZ-TOMAS running, you can monitor the fan from your office. Add the node at the
fan location to eZ-TOMAS, enter the desired delay time, and then left-click on the computer name in the
Network panel of the eZ-TOMAS main screen.  After  connecting, you can see the Fan data at your desk by
selecting the Fan’s Node in the Main window.  You can even reconfigure some aspects of eZ-TOMAS
program at the remote site, such as the acquisition and channel configuration.
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Copy Window
This command allows you to copy the currently selected window to the clipboard.  You can then paste the
copied window into another application, such as Microsoft Word or Excel.

Load Graphic Picture
This command places the selected graphic ( .bmp or .jpg format) into the lower right corner of the
Main Window.

Remove Graphic Picture
Removes the graphic from the Main window.

View Menu
The gauges in the Main Window display the real time data for the selected spectral band.

Plots Menu
Click Plots... on the Main menu to open the Data Display window, or double-click on a gauge to plot that
gauge’s data.

For real-time displays, you can halt and resume the display of data by using the Pause/Continue toggle
button, or use the “P” key on the keyboard. When viewing historical data, you can use the five playback
buttons and the slider to navigate through the data.

You can view either real-time data or historical data via this menu option.

Select the channels to be displayed, the data display format, and the data source.

Data Display Window

Display Window
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Channels, , are inputs channels.  The number of channels that can be displayed is
dependent on the plot display format.  Multiple channels can be displayed on Time, Spectrum, and Strip
Chart displays.

A single channel is shown on Waterfall, Polar and Bode displays.  For Orbit displays, a channel pair
(plotted coordinates) and tach channel (red arrow) are displayed.

A green channel box is a channel that is currently displayed.
A white channel is an active channel not being displayed.
A dimmed channel number is not active, thus there is no data to display.

Tach channel(s) are displayed separately to the right of input channels.

Display formats

Time Spectral   Orbit Waterfall Bode Polar Strip Chart

Recall Preferred Plot Setup

 The Recall Preferred Plot Setup buttons recalls your preferred plot setups.  A limit of four setups can be
defined.

While viewing historical data, the Save Baseline Data button,         , appears to the right of the Preferred
Plot Setup buttons. The Save Baseline Data button can be used to record a snapshot of the data displayed
on the screen. Then, while in Time or Spectrum modes, the recorded baseline can be superimposed on other
displayed data. (While in Time mode, the baseline can also be summed with the currently displayed data,
and the result is displayed.)

In the below example, a Time Display, a Strip Chart, and a Spectrum of Channels 1 and 2 are displayed
with a fourth display showing the tach signal. This setup was saved via the File -- Save Plot Setup -- Plot 1
menu selects.  It was then recalled by clicking on the 1st (left-most) icon above.

Plots Display Showing A Time Display, Strip Chart, Spectrum Display, and Tach Signal Display
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Data Source:

 

Data Source Panel Real Time (Left) and Historical (Right

The default data source is Real Time .  To pause realtime data display, click on the pause icon. 

Historical Data files include History , Overlap , and Alarm Event  files.

History Data is accumulated according to the parameters setup in the ZonicBook Storage Configuration
(Edit Menu).  Click on the History Icon to open the History Data window.

History Data Window

Enter the desired start and end dates.  The default is the entire history file.  Drag the Starting and Ending
Sliders to change the dates in the data entry areas. Click OK.  Then play back the file.

Historical Data is not available via Networking remote access.

Overlap, , processed data is only available if you have used the Overlap Data feature on
the File menu to create an Overlapped file. Overlapped data is double sampled data that is used for better
resolution.

Alarm Event, , opens a table of alarm events.  Select an alarm event in the table to display the
data surrounding the event.

Play Back History, Overlap, and Alarm Event files with the following icon set that is similar to a VCR.

In order, the controls are Rewind, Step backward one record, Step, Play, and Step forward one record.
You can also drag the pointer to a specific area of the file before you start playing back the data.
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Formatting Options
Each plot has its own set of additional formatting options.

The display formatting buttons are located below the display type buttons. Each plot has its own set of
additional formatting options. Not all of the following buttons are available for each plot.

Available buttons are as follows:

The Lin/Log button allows you to switch between Linear and Log Y-axis scaling.  If you
expand the data plot this feature is disabled until the plot is returned to its
original scale with the Autoscale scale button.

The Instrument Scale/Autoscale/User Scale button toggles between the three modes as follows:

The Instrument
Scale button

displays the data based on the instrument’s Engineering Units range. This
is the default display format.

The Autoscale icon toggles between original scale and autoscale.  Autoscale will scale the axes
based on the data being displayed. Autoscale uses the standard 1, 2, 5 type
scaling.

The User Scale
button

displays the data based on your selections.

The Display Gauge
Values button

opens a floating table of gauge values.

Gauge Information Table

The Display Cursor
button

opens a floating table of cursor values.

Cursor Value Table

The Show Limits
button

superimposes limits onto the displayed data.

The Show List
Table button

opens a table of gauge information. The “L” key on the keyboard can be
used to open the list.
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Peak Cursor button,  / 
Peak Cursor  is the default for this toggle button.  During data display the cursor always

finds the peak amplitude in a record.
No Peak Cursor ignores the peak and remains at the same frequency during data display. In

this case you must first drag the cursor to the desired frequency.

The Display Limits
button

superimposes limits onto the displayed data.

The Show Baseline
button

superimposes a pre-recorded baseline on top of display data. This option is
only available in the Time or Spectrum plots.

The Apply Baseline
button

sums the pre-recorded baseline and the currently displayed data. This
option is only available in the Time plot.

The Frequency Axis Mode button cycles through three different x-axis scales:

This option is only available in the Spectrum and Waterfall plots.

Freq. Axis Hz
(measured in Hz)
Freq. Axis kCPM
(measured in kCPM)
Freq Axis Orders
(measured in orders)

The Cursor Mode button cycles through four different cursor modes:

This option is only available in the Spectrum and Waterfall plots.

Normal Cursors

Harmonic Cursors

Sideband Cursors

Peak List Cursors

.

The Orbit Plot Mode button cycles through the type of orbit plot formats:

This option is only available for Orbit plots.

Orbit with SCL format

 Orbit without SCL
format
Orbit with Brg Circle
(an orbit plot including
the bearing circle).

The Overall Trace
button

displays the overall trace. This option is only available for Bode plots.

The RunOut
Compensation
button

displays a graph of the RunOut compensated values. RunOut
compensation is a vector math operation in which the referenced first-
order amplitude and phase vector is subtracted from the displayed first
order vector. This option is only available for Bode and Polar plots.
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Filtering Data

In the example below, the plot on the left is 1 rev of unfiltered data; the plot on the right is using a 1x filter
on 1 rev of data.

Plots Showing Unfiltered (left) and Filtered Data (right)

The below example is showing 1 rev of 1x filtered data on the left and 2 rev of 1x filter on the right.

Plots Showing 1 Rev Filtered (left) and 2 Rev Filtered (right)

Expand Areas on the Graph

X-axis:  Hold down the Ctrl key while you click and drag the mouse across the area of interest.

Y-axis:  Hold down the Alt key while you click and drag the mouse across the area of interest.

Both axes:  Hold down the Ctrl and Alt keys while you click and drag the mouse around the area of
interest.
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Examples of Displays

Time Display, , shows vibration amplitude as a function of either time or rotation for a block
of time data.  The default X axis is time “Full Block.”  If the rotating speed is greater than 0 RPM, the X
axis can be specified as “N” Shaft Revolutions.  Where “N”  is 1, 2, 5, or 10.  One shaft revolution equals
360 degrees of rotation.

Multiple channels can be shown on the Time Display.

Time Display Plot

Spectrum Displays, , show vibration amplitude as a function of frequency.  The frequency
units can be either Hertz (Hz), cycles per minute (kCPM) or orders.

Spectrum Display

Multiple channels can be shown on the Spectrum Display.
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Bode Displays, , show vibration amplitude and phase as a function of rotating speed. The

blue trace is the first order amplitude values. The black trace displays  the overall values .

You can optionally display the Run Out compensation values  on the same plot as a red trace.

Compensation values are specified for each channel in the Configuration.

Run Out Compensation is a vector math operation. The referenced first order amplitude and phase vector is
subtracted from the displayed first order vector.

Bode displays only one channel.

Bode Display

Bode Plot with Overall Trace
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Bode Display with Runout Compensation

Orbit Displays, , show simultaneous time  domain vibration amplitude for a X-Y probe pair.

The red arrow displays the tach reference marker and indicates  the direction of the time signal.  The
default display is “Full Block” of time data.  A limited number of Shaft Revolutions can be displayed
(1, 2, 5, or 10).  The orbit display is corrected for probe location.

You can optionally overlay the orbit onto a shaft center line display by clicking the Orbit w/ SCL button.
The center of the orbit trace in SCL computes the difference between the current gap voltage and the
reference gap voltage. Click the button again to display Orbit w/o SCL. Click once more to display the
Orbit w/ Brg Circle.--the bearing circle clearance is then also shown.

Only one probe pair can be shown on the Orbit Display.

Orbit Display
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Orbit Display with Shaft Center Line (SCL)

Polar Displays, , show vibration amplitude and phase lag on a polar plot format. The
data is corrected for probe location.  Phase lag is opposite the direction of rotation.  You can optionally
display the “Run Out” compensated values (shown as a black trace) by selecting the “Show Compensated”
check box. The compensation values are specified for each channel in the ZonicBook configuration. Run
Out Compensation is a vector math operation.  The referenced first order amplitude and phase vector is
subtracted from the displayed first order vector.

Only one channel can be shown on a Polar Display.

Polar Display
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Strip Chart Displays, , show selected instrument gauge values as a function of date and time.

Strip Chart Display

Waterfall Displays, , show rpm data in 3D.

Waterfall Display
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Reports Menu
eZ-TOMAS has two types of reports – Statistical and Alarm Log.

Statistical Report
The Statistical Report lists the historical spectral band data.  It includes the instrument, the engineering
units, the minimum value, the mean average value, the maximum value, and the standard deviation by
channel.

Statistical Report

The report can be saved as an ASCII text file for further use.

This data can be used to generate or fine tune limits.  You can have eZ-TOMAS automatically compute
limit values by selecting Generate Limits on the File menu.  You can view and modify the limit by
selecting Limits on the Configuration menu.

1. On the Reports menu select Statistical, the History Data window will open.

History Data Window

2. Drag the pointers across the scale to select the Start Date and Time, and the End Date and Time for
the report.  Click the OK button.  The Report will then be displayed.

3. Save the Statistical Report as an ASCII text file by selecting Save the Report on the File menu in this
window.
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Generate Limits
Statistical reports can and should be used to automatically generate limit values based on historical data.
After your project has been running for several hours, there is probably enough data in the history file to
have eZ-TOMAS automatically generate limits.  However, you probably will want to edit these limits if the
machine is experiencing amplitude or frequency shifts.

This feature can be used at any time during the life of a project.

1. On the Reports menu select Statistical; the History Data window will open

History Data Window

2. Drag the pointers across the scale to select the Start Date and Time, and the End Date and Time for
the report.  Click the OK button.  The Report will then be displayed.

Statistical Report Window

Limit values are not used if the HiHi  limit value minus the LoLo limit value is less than
5% of the instrument scale OR the limit value is outside the instrument range.
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3. In the Statistical Report window select Generate Limits on the File Menu; the Limit Generation
window will open.

Limit Generation Window

4. Select the Spectral Bands for which limits should be generated.
5. Specify the Standard Deviation to be used for Alerts and Alarms.  Two High and two Low limits will

be defined for each channel’s operating condition.
6. If you want to change the Overall % Storage Trigger (set in the ZonicBook Configuration window

under the Storage tab), click to place a checkmark in the Compute Using check box and enter the
new standard deviation to be used.

7. Click the OK button.  You will be asked if you want the Limits saved to disk.  Click Yes.

The limits will be generated and can be reviewed/modified in the Edit Limits window, as shown below.

Alarm Log Report
The Alarm Log contains the last “N” number of alarms.  The number of alarms was specified in the
ZonicBook Configuration window under the Storage Tab.  The Alarm Log displays, in a grid format, the
Channel, its name, the date and time of the alarm, the type of alarm, and the value of the signal at that time.

Alarm Log Report

HiHi / LoLo (Danger) limit values = average +/- (4 * standard deviation), unless you changed the standard
deviation in the Limits Configuration window.

Hi / Lo (Alert) limit values = average +/- (2 * standard deviation), unless you changed the standard
deviation in the Limits Configuration window.   To save this report, select Save the Report on the File
Menu at the top of this window.

To export this data to an ASCII file, select Backup/Export on the File menu in the Main window.
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ZonicBook Configuration
The option creates a text file that contains the details of the current projects configuration.

ZonicBook Configuration Report
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Security Menu
eZ-TOMAS has 3 Security Levels.

Level 1 has very limited privileges – Exit, Print, Generate Alarm Log Report, and View Gauge data in the
Main menu.

Level 2 has only a few limitations.  The Level 2 operator cannot start a new project, Erase the History file,
or change the security password.

Level 3 has full privileges.  Level 3 is password protected.

No password is required to go from Level 3 down to Level 2 or Level 1.  However, the project password is
required to move from Level 1 or Level 2 to a higher level.

Change Password
This command opens the Project Password window.

Edit Password Window

Type a password that you can remember and press the <Save> button.  The window will then clear your
typing.  Retype your password and press the <Confirm> button.
The new password is immediately accepted.
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Glossary
Several terms and acronyms are used throughout the following discussion, including:

Blocksize: The number of data samples used in the FFT process.

Data Block (Block of Data): An array of data samples used in the FFT process. The Data Block array size
is the “Blocksize” value.

Spectral Resolution: The Analysis Frequency divided by (the Blocksize divided by 2.56).

The Sampling Rate is 2.56 times the Analysis Frequency.

For example,

Given an analysis frequency of 1000 Hz and a blocksize of 2048,

The sampling rate would be 2560 samples per second for each channel, or 2.56 times the Analysis
Frequency

The Time Data Block consists of 2048 values.

The Spectral Data Block consists of 800 values.

The Spectral Resolution would be 1.25 Hz per spectral line.

Additional Notes
Here is a list of common suggestions for you to use eZ-TOMAS more effectively.

1. Make sure your ZonicBook Dip Switches are configured correctly.  (Typically:  Single Ended, AC
coupled, and ICP ON.)

2. Use a standard channel location convention.  (Typically:  A single Tach is channel 8.)
3. If for some reason, you have an error where eZ-TOMAS does not boot up, you can work around

the problem by deleting the file, “tomas.ini,” located in the executable’s directory.  This file
identifies the last Project opened.  You can delete this file without affecting your data.  Try reopening
the last project.

4.  If you still experience an error.  Please send an email to productsupport@iotech.com

mailto:productSupport@iotech.com
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Program Function Keys 4
Function Keys can be programmed to perform a series of key strokes.  These are kept in a separate file
“tomasfkeys.ini.”  Below is the sample file included with the software distribution.  Please note that the
first 4 characters must be Fnn=, where nn is the two digits of the Function Key of interest.

F01=HELP
F02=ACQ Turn acquisition On/Off
F03=LC Turns Limit Check On/Off
F04=SAVE Saves Snap Shot file
F05=pathfilename.tom1(all lowercase) Opens the user defined project
F06=c:\program files\data\motor.tom1 Opens the “motor” project
F09=PRINT Opens the Print window

Customize tomasfkeys.ini file
Open the file in notepad or a similar text editor.

Type the definitions for the function keys you want to use. The key words must be as listed above.

Acceptable Acceptable Not Acceptable
F01=HELP F02=ACQ F10=HELP
F02=ACQ F03=LC F02=ACQ
F03=LC F10=HELP F03=LC
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